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The Toolbox
These are the most commonly used tools and what they do. Each tool has many more options you can explore 
when you have some time - check the last few pages of this guide for some great effects.

Like all tools and windows, the Toolbox can be moved around and placed wherever convenient. 
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Indicates default tool    (Keyboard shortcut in Bracket)

Selection tools
Selection  (V)  

Direct Selection  (A)         

Drawing &  Type 

Pen  (P)
Add Anchor Point 
Delete Anchor 
Point 
Type  (T)
Type On a Path  
(Shift+T) 
Line (\)

Rectangle Frame  (F)

Rectangle  (M)

Transformation tools
Rotate  (R)

Scale  (S)

Gradient  (G)

Navigation tools
Eyedropper  (I)

Hand  (H)

Zoom  (Z)

Toolbox overview 

- Select and Resize Containers & Objects

- Select items inside containers (like photos)

- Modify objects, like text wrap paths

- Create Text boxes and type in them

- For fun text along objects (use sparingly!)

- Draw Rule Lines

- Create Containers for your photos

- Create Shapes that will have solid colour

- Choose which point to rotate around

- Keeps Shapes proportional

- Add Boxes with gradient �lls

- Add Boxes with gradient �lls

- Grabs Desktop and moves it on screen

- Zoom in and out of objects

- Switches between Colour and Stroke (outline) if objects

- Applies formatting to Text or Container

- Applies Colour and Gradients based on current settings

- Switches between outline and Print Preview modes

What we use them for:A - SELECTION TOOLS	 WHAT THEY ARE USED FOR:

B - DRAWING & TYPE

C - TRANSFORMATION

D - COLOUR & NAVIGATION
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THE CONTROL Palette <Window/Control>
The Control Palette will change with each tool you select, and is where you change settings and how objects 
appear. The three views below are the ones you will work with most.

SELECTION MODE (USED WITH SHAPES AND PICK TOOLS)

TEXT MODE

PARAGRAPH MODE

The reference point used for calculations and 
modifications (Scale, rotate, etc.) Text wrap options

Location of the 
reference point (or 
cursor)

Size of object Scaling - keep two values 
identical for photos.

Rotation and Skewing

Fitting options for 
photos

Flip and Mirror

Fonts & styles
Change case

Kerning - the space between characters

Size and line spacing

Scale stretches or compresses letters

Text alignment Dropcaps

Apply Paragraph StylesSpacing from edge of text frame Number of 
columns in text 
box

NOTE: Many of the buttons on the Text and Paragraph Control Palette repeat, so you can choose to work with 
the one that has most of the features you want to see. (You can switch by pressing on the A or ¶.)

Getting Started with InDesign
InDesign is part of the Adobe Creative Suite (CS) and integrates with Photoshop, Illustrator and others.

InDesign is a way to lay out containers for work created elsewhere, and to do some basic image creation.

You will create containers for images, text and graphics, and have full control on how they are combined.

You can print out your files or create JPGs or PDFs of documents that can be easly shared online.

In Design maintains links to all the objects you place in your document, so you should make sure you do not 
delete any of your source files (photos, text and graphics) or your file will be missing items next time you open it. 
This keeps InDesign files small, and if you change an image, it will automatically be updated in InDesign.

Stroke size and 
style
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Zoom out so you can see your whole spread.
<View / Fit Spread in Window>

Start with your dominant image (2-3 times larger 
than the other photos) This image should cross the 
gutter. 

PHOTO BOXES

SIZING AND MOVING BOXES

- Use the Frame Tool to make all the photo 
boxes you will need.
(The boxes should have an X through them)

- The boxes should touch the correct columns 
on the sides.

- Use the grid to line them up horizontally, but 
there is no need to ‘count boxes’ to match the 
sample - as long as you are close and within 
columns.

Use the selection tool to move objects. 
Make sure your boxes line up.

- Keep 1 pica space around your objects.
(our grid has dividers at 6 points and 
darker ones at full picas).

- This is what your page should look like 
at this point.

SAVE YOUR WORK
Use <File / Save As>

PLACING TEXT & CAPTIONS
Next create boxes for your headlines, body and captions. 
Write these before starting your spread, so you know how much (or little) space you need.
Place captions next to the image they describe. 
Do not trap any white space with your captions.

Use the Text tool to draw boxes.
Copy and paste text into your boxes.
(There is a text file in the <InDesign Training> folder.)
- Open <Text.doc> in word.
- Select the text you want and copy <Ctrl C> it to the clipboard.
- Switch to InDesign.
- Click your text tool in your text box and place <ctrl V> the text.FU
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The template should already contain columns and a grid, 
but if you can’t see them, or change them by accident, here 
is how to get them back.

In the pop-up window:
- Check that your margins are set correctly.
- Choose 4 columns with a 0p6 gutter. 

Follow All steps EXACTLY To 
REcreate this Spread

Make sure you can see: 	 - The Toolbox <Window / Tools>
				    - The Control Palette <Window / Control>
				    - The Columns and the Grid (see last step on previous page if you can’t see 			 
				    them).

- Copy the files from the <InDesign Training> folder into your own working folder. 
- Open the <template.indd> file to start the layout.

PRACTICE LESSON

SETTING UP

Go to <Layout / Margin and Columns>

RED text in <> brackets represents Windows commands or file names used 
for Navigation. Blue text refers to names of tools.

NOTE:Get 
Started
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PULLED QUOTE (TEXT WRAP)

Use the Selection Tool and <click> on the text box 
you want to apply a style to. 

Use the the Textwrap options in the Control Palette 
to apply text wrap. 

You can also use the <Text Wrap> tab on the right of 
the screen to pick the style.

Update the folio, which tells us the page number and section.
- Switch to the master page to update these items by choosing the 
  <Window/Pages> tab and click on the Master Page for your page.

- Select the Folio text and update it on both sides.

- Do not change the ‘A’ where the page number should be.
  This means the correct number will be placed automatically.

- Add your name to the byline at the bottom.

- Switch back to your working document.

FOLIOS AND CREDITS

The layout with 
‘tweaked’ text and 
folios.
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FLOWING TEXT FROM ONE BOX TO ANOTHER
Use the selection tool 
and click on the small 
+ at the edge of the 
text box.

You will get a 
loaded cursor.

Click in a new text 
box (or create one) 
and the text will 
flow there. 

This is
more or
less what
you should
have at this
point. 

PLACING HEADLINES
Type your headline in a text box. 
We will apply styles next, so you don’t need to worry about font size and style 

Styles show up in the text control palette, 
but they also have their own palette on the 
side. 

(Click the <Paragraph Styles> tab on the 
right of the screen.)
Use styles to save time and to make sure 
your pages are consistent.

If working on yearbook pages, make sure 
not to change the preset styles, or we won’t 
know if your pages are off!

PARAGRAPH STYLES
Use the Selection Tool and <click> on the text box you want 
to apply a style to. 
Use the the <Paragraph Styles> tab on the right of the screen 
to pick the style.
If you have text selected, you can use the Control Palette to 
apply styles.

Now choose 
the correct 
style for 
each piece 
of text

APPLYING STYLES
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This is what your completed spread should look like. If not go back to see what you need to change! 
(If you have not done so yet, fix this space.)

View your whole spread by zooming out a bit 
and clicking on the preview mode.

PREVIEW

- If an object is behind another, and you want to 
change where it is, you can change the order. 

- Objects can be shuffled to get the order you want.

Layers

DONE! 
NOW THAT YOU KNOW HOW TO USE INDESIGN, YOU CAN START SETTING
UP YOUR OWN DOCUMENTS!
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Use <File/Place> to choose a number of images to place.
- When placing multiple images you will see a small preview of the image next to 
your cursor. Use the up and down arrows to switch between images.

Place your images in the correct boxes.

Use the Fitting buttons on the Control Palette
or use the menu to fit your image or fill the frame.
<Object / Fitting / Fill Frame Proportionally>  

Make sure you keep your images proportianal. Photos 
should never be 
stretched or scaled out of 
proportion.

Check that both scaling values remain identical.
- Hold down your <shift> key when dragging to resize an 
image so that it will remain proportional.

PLACING PHOTOS

ROTATION
One of the images is rotated to keep the cart from driving 
off the page.
 - Use the Direct Selection Tool (white arrow) to select the 
image.
 - Change the rotation value to level out the cart.

The left-most image overlaps another, so to make it stand 
out it needs a border - called a ‘stroke.’
- Bring it to the front: to select it use the menu
  <Object / Arrange / Bring to Front>.
- To give it a stroke of 6 pts use the Control Palette 
or the Stroke Window <Window Stroke>.
- Make sure the Stroke is white - pick in the colour tab  
<Window / Colour>.

- Make sure the outside of the frame lines up with the grid, 
and the edge of the image is the same as the one next to 
it.

Click here to switch 
between Fill and 
Stroke

You will see 
the orange 
image frame 
rotate

STROKE (OUTLINE)
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Items that you want to be identical on each page, or in a set locations each 
page, should be placed on the MASTER PAGE.
This is a special layer that will be identical and placed under each page you 
create in your document.
It is possible to create several master pages and then apply these to pages 
within your document.

Folios and page numbers should be on the master.	
To create a folio:
- Switch to the master page using the Windows Tab <Window/Pages>.
- Click on the Master Page for your page.
- Anything you create here will show up on every page that uses that master.
- To insert an automatic page number
<Type/Insert Special Character/Markers/Current Page Number> or 
<ALT+SHIFT+CTRL+N>.
- You should see an A which means the correct number will be placed auto-
matically.
	
- To change your page numbering:
- Go to <L:ayout / Numbering and Section Options>.
- Change your page numbers. (Make sure you know which 
page you are on, or some unexpected things can happen!)
- If your folio is covered by objects, you can: 
- Copy the Folio and <Edit / Paste in Place> it on the working 
page.

OR:	

- Cut the object from the working page
- Paste in place on the master layer 
- Move it to the back of the folio.

Starts numbering from that page 
- so make sure you are on your 
first page!

You can set prefixes or markers 
for different sections.

Master Pages

Paragraph Styles
To Create a new Paragraph Style:
- This is the text you want to base your style on.
- Go to the Paragraph Styles Tab 
<Window/Type&Tables/Paragraph Styles>.
- Click on the small menu link.
- Give your new style a name.

NOTE: (Character Styles and Dropcaps)
- You can also create character styles (they are useful if you want to set up a drop cap).
- Procedure is the same as for paragraph styles, but does not include paragraph formatting.
- Dropcaps are set up by double clicking on the paragraph style and then choosing the size and character style of 
the dropcap.
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SETTING UP PAGES

Choose how many pages in your 
document (you can add more 
later).

To view the Grids you have set up, go to 
<View / Grids & Guides / Show Baseline Grid> 
and / or
<View / Grids & Guides / Show Document Grid>. 

<File / New / Document> or <CTRL+N> will bring up the new document dialogue.
Here you set document Size, Margins and Columns.
To change these later you have to go to <File / Document Setup> and to <Layout / Margin and Columns>.

Next you should set up your grids in preferences <Edit / Preferences / Grids> or <CTRL+K>.

Do you want to see two 
pages at a time (as in a 
book) or only one?

Landscape or protrait?
Enter your size. You can use any 
measurement you like, just enter 
‘in’ ‘cm’ or ‘p.’

Choose how many columns 
per page, and the space 
between them (usually 1p or 
0p6).

Set margins for your document. 
Depending on the guides you will 
be using, you might want to change 
these values later, so the grid and 
columns line up!

There are many 
preferences you can set 
up, such as the unit of 
measurement to use. 
Pica is the North 
American standard in 
printing, but the rest of 
the world uses cm or 
mm, while you are most 
likely used to inches! 

Baseline grids are evenly 
spaced horizontal lines. Good 
for newspapers and when 
using columns.

Document grids are evenly 
spaced lines. Good for creative 
layouts and even spacing.

Guidelines will show up dark
Subdivisions will be lighter in 
the grid

Choose any colour you like!

Choose if grids will be 
on top of your work, or 
behind.
- Grids and guides will 
not print!

Also select: 
<View / Grids & Guides / 
Snap to Document Grid>. 
This makes it is easy line up 
all your objects.

MAKE INDESIGN YOUR OWN
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Final Checklist
Please verify all points below prior to 
submission:
Convert all colours to CMYK
•	 *Optional: Manually convert all photos and images to CMYK. Photos should be converted in Photoshop. 

Any images left in RGB mode will be converted automatically and may not match the conversion tables on 
your computer.

Confirm all linked images are press-ready
•	 Images must be 300-350 dpi (scaling above 100% will cause error).

Remove all non-printing items
•	 Remove all non-printing items by deleting all objects outside of the printed area.

Layers
•	 Go to Window > Layers. In Layers window, click on the pull down menu, select Delete Unused Layers. 

Also remove any layers which contain elements not used in the final print job.
•	 Click again on the layers pull down menu, select Merge Layers.
•	 ***Only merge layers on your inside pages. Do not merge layers on your cover or dust jacket, or on pages 

that will have added elements such as silkscreen, foil or lamination.

Fonts
•	 To bypass submitting fonts, you can turn your fonts into vector graphics. First, select all objects. Then, go 

to Type menu > Create Outlines. This will make the text un-editable, but will also prevent delays in the 
case that an incomplete set of fonts are supplied.

•	 ***TIP: Keep a record of all fonts used. Because converted text is no longer editable as type, you may 
need your font files for future revisions.

Page Set up
•	 If pages were not created using the templates provided to you, ensure that each page is the correct size - 

8 1/2” x 11” or 9 x 12”.
•	 Ensure there is a bleed around all sides of your pages - at least 0.118 inches (0.9 picas)
•	 Ensure there is a slug at the bottom of each of your spreads - at least 2 inches (12 picas) and includes 

your school name and your job number.

Page Numbers
•	 If page numbers aren’t included on every page as part of your design spread, please include them in the 

slug to ensure there is no confusion in the plant.

Provide one spread or multiple spreads per file.
•	 Do not submit single pages unless they are the first or last pages of your yearbook.

File Name
•	 Save files as Pages 002-006 for example. Use three digits in the number and do not include page names.
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Colour Swatches
To create a new swatch:
- Choose your colour in the 
Colour Tab <Window/Colour>.
- Click on the small menu link.
- Choose ‘Add to Swatches’.
- The colour will be added to your swatches.
- The name will be the CMYK value.
To give your new style a name:
- Double click on the swatch name in the Swatches Tab
- Uncheck the box ‘Name with Colour Value’ in the dialogue box
- Give your swatch a name and click OK.

Checking Links, Image 
Quality and Styles
LINKS
- InDesign will check Links when you open the file - if you get errors you 
have to relink images before getting ready to print.
- The Links Tab will show you errors <Window/Links>.
- Yellow flags mean the images have been changed – update them
- Red Flags are broken links and will not print correctly!
   • Click to repair.
   • Browse to locate & re-link.
- Use the icons at the bottom of the tab to relink/update the images.

IMAGE QUALITY
Images have to be high quality for printing - to check if they are OK:
- Select the image and see the Info tab or <Window/Info>.
 - Effective ppi has to be 250 for B&W, 300 for colour.
- Both values have to be same or the image has been distorted.

TEXT STYLES AND COLOURS
- Select text boxes and open the Paragraph Styles Tab.
- A ‘+’ next to a style means it has been changed.
	 - Could be a size or colour change, or just a change in alignment.

Getting Ready to Print and
 Submit
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File Conversion to PDF
Please verify all points below prior to 
submission:
Have all elements of your InDesign spread on the same computer
•	 If the spread was created on one computer, but exported on another, the links and fonts may not ex-

port, unless files are shared among all computers. You will receive a warning sign that fonts or links are 
missing if this is the case. To create ease and certainty when exporting, you may wish to package your 
InDesign files first. Please review the Packing InDesign Files sheet for further assistance.

Save your file
•	 Once your document is ready for submission, do a final save in InDesign.

Export your file
•	 Go to File > Export
•	 Chose a location and create a file name (Pages xxx - xxx)
•	 Chose Adobe PDF as the file type
•	 Click Save

Chose proper export settings
•	 Under General, chose the range of pages to export. Do not include pages not intended for printing
	 Check the box marked Spreads
	 Check the box to View PDF after Exporting so that you can double check your page
	 Check the box Optimize for Fast Web View
•	 Under Compression, ensure all information in boxes is correct:

Package InDesign Files
Save File
•	 Save File as Pages xxx -xxx

Go to File > Package
•	 Printing Instructions appear 
	 Under File name, label the name appropriately, Pages xxx - xxx
	 Under Company type in your school name and Job # (your job number is listed in the slug of the      	
	 	 templates we gave you.)
	 No need to fill out the rest of the information.

If no concerns:
•	 You will be prompted to save the entire file. Save it as Pages xxx - xxx Folder
	 Check the boxes marked: Copy Fonts, Copy Linked Graphics, Update Graphic Links in Pages, and	
	 	 Include Fonts and Links from Hidden Layers.
•	 Package

In most cases, concerns will arise:
•	 Under Fonts, ensure that the fonts chosen have an ‘OK’ status. Otherwise, select the appropriate fonts
•	 Under Links and Images, check that each link is CMYK, and Linked (if the box below, stating Show      

Problems Only is not checked, check this to reduce your list.) Any images left in RGB mode will be 
converted automatically and may not match the conversion tables on your computer.

•	 If your links have been modified, select them all and click Update
•	 If your links are missing, you will need to manually update them. To do this, cancel the packaging      	

	 process. Open up your links palette under Windows. Select the links which show errors and Go To 
Link 	 to see the image in question. Now, you must find the link. If it’s on your computer, you should 
be able to Update Link. If it’s not, you’ll have to transfer it over.

•	 Now, proceed with the steps above to package your file.
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Here are some popular effects and how to apply them. 
The key is to try many settings and see what works best.
Check the last page for how to set up styles, so that you can duplicate the effects throughout your document.

Advanced Effects

Drop Shadows
- Select object
- <Object / Effects /Drop Shadow>
  or  <ALT+CTRL+M>.
- Change colour/parameters (Colour 
Direction, Size & Blur).
- You also can also apply a lot ot other 
Photoshop effects here.

Feather
- Select Object
- <Object / Effects / Basic Feather>.
- Change feather width.
- Check the Preview box to see the effect.

Corner Effects
- Select Object
- <Object / Corner Options>.
- Change Style & Width.
- Check <Preview> to see the effect.

•	 Under Marks and Bleeds, check the boxes All Printers Marks, Use Document Bleed Settings, and 
Include Slug area

•	 Under Advanced, select Transparency Flattener and choose High Resolution

Export
•	 Address any warnings that appear.
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Ignoring Text Wrap

If you do not want text wrap to ap-
ply a text frame:
- Select frame.

- Go to <Object / Text Frame 
Options> and select <’Ignore Text 
Wrap’>.

  

Text Wrap
- Select object.
- Go to Text Wrap Tab <Window / Text Wrap>.
- Choose the type of text wrap and offset value in the 
dialogue box.
- Create your own edges by creating new points with 
the Pen Tool. 
			   - Move points with the 
			     Direct Selection Tool.

- Note: If you create a clipping path 
in Photoshop it will be detected 
here.

Fitting Text to Path
- Create the path (circle or line).
- Switch to the Type on a Path Tool <Shift+T>.
- Click on the Path to create a starting point .
- Type or Paste your text.
- Make the path invisible (no fill or stroke).

This is a great effect, but be careful because you won’t be able 
to change the text once you have followed these steps.

Photos Inside Text

- Create your text.
- Convert it to a shape <Type / Create Outlines>.
- Resize the text to suit your design.
- Pull on nodes to change shape.
- Select the text with the Direct Selection Tool.
- Place your image in the outline Ctrl+D or <File / Place>.
- Now fit your image to the frame.

 Control spacing of text when the text in a box is too close to 
the edge of the box.
- Change the Indent to move over text.
- Change the Baseline Shift to move text up or down.
- Another solution is to create separate text box.

Fine-Tuning Text Boxes
  Before		        After

  	 Baseline Shift		      Indent

FU
T

U
R

E
BOO




K
18

Transparency
- Use the Transparency Tab or 
<Window/Effects/Transparency>.
- Use the slider to adjust how much shows 
through an object.
- This is a good way to put captions over 
photos if you put the text in a semi-
transparent text box.

Compound Images
You can group image frames and place photos in all of them at once, 
or create complex combinations of shapes and use them as image 
containers:

TO CREATE COMPLEX SHAPES:
- Select all objects together (hold down shift and click)
- Combine the objects <Object/Pathfinder/Add>.

TO TAKE AWAY PART OF THE SHAPE:
- Place the shape you want to cut out on top of the 
  other containers.
- Select all objects together.
- Cut out the shape  <Object/Pathfinder/Subtract>.
- Ready to place one image across multiple frames. 
HINT: If you want to place an object into the shape you 
cut out, make sure to copy and paste the cutout shape 
and save it for placing the image later!

TO HAVE ONE IMAGE FILL SEVERAL SHAPES
- Select all objects together and make one path
<Object/Paths/Make Compoud Path> / <CTRL+8).
- Ready to place one image across multiple frames.
HINT: This allows you to maintain the stroke given to 
each object as part of your images.

TO RELEASE images from the compound path 
<Object/Paths/Release Compoud Path>.
- Your image will stay in one of the shapes.
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Extraction and Clipping Paths
(using Photoshop)
The effect everyone wants! Cutting objects out of their background and placing them on pages. 
- Technically this is easy - the only challenge is in selecting and cropping the part you want in Photoshop.
- If you have CS3 or later, this is now much easier, using the Extract Filter and Refine Edge Tools. 

- Open your image in PHOTOSHOP and Crop the image down to the part you want to use.
- Duplicate your layer so your have one as a back-up.
(Drag your layer onto the paper icon at the bottom of the layer palette.)
- Rename your layers (double click on name.)

EXTRACT THE IMAGE
- Apply the Extract Filter <Filter/extract>.
- In the new window zoom in until you can see 
the edge clearly.
- Choose the Edge Highlighter (top tool).
- Make it wide enough to cover the whole edge.
- Enable smart highlighting to get a smaller edge.
- Use the eraser to make corrections (zoom in if you need to)
- When the entire image is outlined, fill it using the bucket tool  <g>.
- If your whole image fills with colour, you have a gap in 
  your outline you need to fix.
- Click Preview to see what it will look like.
- Use the cleanup tools to remove spots the filter 
missed, or add areas where it took too much.
- Click <OK> to apply the extracted filter.

REFINE THE EDGE
- <CTRL+Click> on the extraction layer in the layers palette.
- Make sure you are using the original layer and 
- Choose <Select/Refine Edge>.
- In the dialogue use different previews to check the edge.
- Increase the radius to bring out detail.

- Increase contrast to fill in soft edge areas.
- Use smooth to round off jagged edges.
	 - Use the contract slider to increase and decrease 
	 size of selection.
	 - Click <OK> to apply the changes.

Your image is ready and cropped.
You can now create a mask or a path
if you want to use it in InDesign.

- Create a new work path (path window).
- Choose a tolerance (0.5 pixels works well).

- Double click on the path and rename it.
- Create a clipping path  (path window).

- Choose your named path in the dialogue 
- Save your file as a Photoshop (.psd) file. 

- Switch to InDesign and place your picture.
- Select and adjust the text wrap style and distance 
as needed.


